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Welcome  
 
The basic tasks that most users want or need to learn to start using Fusebox are covered in 
this guide.  It provides an overview of Fusebox, the portal where a single interface allows 
access to all browser-based applications for which you are set up and entitled to use.  Fusebox 
is designed to support multiple types of industries and merchants. 
 
Note: You may not have access to every feature because access is restricted by your user role 
and entitlements.  
 
The following topics are covered. 
 
• Getting Started 

Getting Started describes the basic tasks that most users want or need to learn to start 
using Fusebox. 
 

• Security 

Security provides information on security within the system.  
 
• Accessing Fusebox 

Accessing Fusebox provides an overview of the general requirements for your initial log 
on. 
 

• Fusebox User Interface Overview 

Fusebox User Interface provides an overview of the Fusebox user interface and its 
features, including key information you need to know to effectively use the system. 
 

• Welcome to Elavon Global Gateway  

Welcome to Elavon Global Gateway provides information on managing messages, security 
settings, and tasks associated with the Welcome Menu. 

 
• Available Applications 

Available Applications lists the functionality of the application and what options you have 
as a user. 

 
• Common Tasks 

Common Tasks lists known environmental settings that can affect Fusebox users when 
performing operations in the portal. 
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Chapter 1 - Getting Started 
 
This section describes the basic tasks that most users want or need to learn to start using 
Fusebox. It provides an overview of Fusebox, the portal where a single interface allows access 
to all browser-based applications for which you are set up and entitled to use.  Fusebox is 
designed to support multiple types of industries and merchants. 
 
The following topics are included:  

• Fusebox Overview 

• Merchant Hierarchy   

• User Profiles and Entitlements 

 
 
Fusebox Overview 
 
Fusebox is a hosted payment gateway. Payment gateways act as consolidators of transactions, 
sitting between the merchant's Point of Sale (POS) and Payment Management system (PMS) 
and a bank or the processing network of an acquirer. Gateways provide secure multi-point 
connectivity across a merchant’s enterprise. As a result, merchants do not have to worry 
about certifying and maintaining numerous payment systems and interfaces. By consolidating 
payments, gateways also provide flexible reporting to simplify reconciliation and settlement 
and customer service functions. 
 
Merchants who use the hosted gateway solution have an agreement with Elavon for high-
speed and high-availability payment processing services. The agreement is subscription-based 
and includes management of payment processing applications, customer support, high-speed 
network access to their third party processors, and merchant services. 
 
Fusebox contains a set of high-value services designed to meet the needs of Value Added 
Resellers (VARs), merchant customers, and others in accepting and managing multiple kinds of 
transactions, which include: 
 
• Chargeback Processing 

• User Management 

• Batch and Transaction Management 

• Reporting 
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Merchant Hierarchy 
 
The Fusebox merchant hierarchy is a way of organizing merchants in a multi-tiered structure 
that organizes processing, pricing, correspondence and reporting options. 

Structure 
 
Fusebox data is organized into a set of nodes in a tree-like structure. Starting at the top of an 
organization, the structure is set up to mirror groups within business units in a hierarchical 
structure. The benefits of using this type of data organization include: 
 
• Levels are created where transactions are acquired 
• The location of where payments are made and funds collected is identified and allows you 

to trace every transaction to a location 
• Provides the ability to determine how the merchant receives information on acquired 

transactions 
• The information on acquired transactions is easily reported to the merchant 
• Fusebox applications are designed to handle a variety of tasks, requiring different users to 

perform various functions in the process. 
 
By establishing hierarchy information that is specific to your business, your administrator can 
manage user access easily by assigning profiles and roles to a point in the hierarchy structure. 
Your administrator assigns you to a profile. The profile allows you access to complete all 
necessary tasks associated with the level and applications you need. Typically, your 
administrator will advise you which hierarchy to use. 
 
User Profiles and Entitlements 
 
Profiles and entitlements are either actionable or grantable and provide an added layer of 
security that creates a separation of duties between those that need to perform functions in 
the portal and those that only need to set up users to perform those functions. 
 
Profiles are either Actionable or Grantable 
 
Actionable Profiles 
This profile allows the user the entitlements or privileges to perform particular functions in 
the portal. Each actionable user profile has a corresponding grantable profile. 

 
Grantable Profiles 
 
This profile is only assigned to administrators who assign profiles and entitlements to other 
users. As part of your profile, you may be assigned a user role with the ability to grant or 
assign roles to new users. 
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Entitlements 
 
Entitlements are grouped into a set of privileges, and you are assigned a group of 
entitlements or a profile set. You can only see data pertaining to the hierarchy node you are 
assigned to and the sites associated with that level. If you need access to different 
entitlements other than what is available in one set, you can be assigned another profile that 
includes the entitlement you need. 
 
When you log on to Fusebox, the entitlements you have for the Fusebox application are 
recognized through your user profile. Entitlements are used by the Fusebox interface and web 
services to show or hide user actions. You may not have access to every feature and 
application because access is restricted by your user role and entitlements. 
 
There are two parts to your profile: the applications for which you have access rights and the 
data for the entity or site the application uses. 
 
Your login is tied to the role you perform at your job, and the Merchant Administrator assigns 
you and other users the correct entitlements to work within the Fusebox application. 
Typically, your Site Administrator will inform you of the correct hierarchy, entity, or site you 
should use. 
 
The following Fusebox features support added security when granting user profiles and 
entitlements: 
 
• Each profile has a corresponding Grantor profile that can be assigned to a user. The 

Grantor profile provides the ability to give other user profiles and entitlements in the 
portal. 

• Administrators who set up other users must be assigned to each of the grant profiles they 
will need when creating the other users. 

• You do not need to be assigned the actionable profile to grant that profile to a user. For 
instance, you can be assigned to Grant profiles to Online Case Management, but you do 
not need to be able to use Online Case Management in your profile. 

• If an administrator has not been assigned to a particular grant profile, it will not appear as 
an option to them when creating other Fusebox user accounts. 

• The Universal Grantor profile provides the ability to assign grantable profiles to another 
administrator user. 

• Only certain Elavon internal users are assigned to the Grant Universal Grantor profile to 
retain control over the creation of other administrators.
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Chapter 2 - Security 
 
Fusebox incorporates the latest data security protections and meets the most stringent 
Payment Card Industry (PCI) and Payment Application Data Security Standard (PA DSS) 
requirements. 
 
Fusebox uses a combination of business procedures and system protections to manage user 
access to the system. Users are configured in Fusebox using a common user management 
tool. Underlying web services allow for user authentication and security based on the 
company’s business processes. Fusebox processes and procedures provide security within the 
system. Some examples include card masking, tokenization, system timeout, and password 
security. 
 
Topics in this section include: 

• Tokenization 

• Card Masking 

• SAFE-T Suite Overview 

• Clear Card Guidelines 

• System Timeout 

• Password Security 

 
Tokenization 

 
Fusebox offers a tokenization solution that replaces card account numbers with unique IDs, or 
tokens, used to process, update, and track transactions throughout their life cycle. Card 
masking eliminates, or limits, the Point-of- Sale (POS) application’s need to store sensitive 
cardholder data. Tokenization reduces the scope of PCI audits because there is no cardholder 
data that must be secured. 
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The Token ID allows external users the ability to store a token, which in turn is a reference for 
the credit card information. This token can be used later to perform transactions without 
entering the credit card details. 
 
Some merchants use Elavon transaction encryption and tokenization security features. 
 

Card Masking 
 
Based on your user security settings, you either see masked or unmasked credit card numbers 
in reports. When entering credit card numbers as search criteria, you can enter either masked 
number formats or full numbers. 
 
Masked credit/debit card numbers display in the formats identified     below. 
 

• You may enter either a full or masked account number. To search successfully using 
masked account numbers, follow the guidelines below, using an asterisk (*) to replace 
each masked digit. 

 
• For account numbers containing twelve or more digits, enter the first six and last four 

digits and replace the center digits with an asterisk (*) for each digit. For example, 
'1234567890123456' is masked to '123456******3456' and '123456789012' is 
masked to '123456**9012'. 

 
• For Account numbers between six and eleven digits, enter an asterisk (*) to replace all 

digits except the last four. For example, '12345678901' is masked to '*******8901' 
and for account numbers having fewer than six digits, enter the full account number, 
these are unchanged. For example, '12345' or '12' will be returned as '12345' and '12', 
respectively. 

 
•  '123456' will be masked to '**3456'. 

 
The following security measures are in place for users who are allowed to see full, unmasked 
card account numbers in reports, such as the Transaction List report. 
 

• When printing or saving reports that have unmasked card numbers, a warning 
message appears.  

 
• The expiration date does not appear in reports when full card numbers are displayed 

 
• The name of the cardholder does not appear in reports when full card numbers are 

displayed 
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SAFE-T Suite Overview 
 
SAFE-T Suite - Secure and Flexible Encryption & Tokenization  
 
Elavon's SAFE-T Suite is integrated with Fusebox. SAFE-T Suite features a combination of 
advanced encryption and tokenization technologies that protect cardholder data without 
impacting the way customer card information is used throughout your business. 
 
SAFE-T Suite provides end-to-to end data protection by removing actual cardholder data from 
the business environment. 
 
Encryption Protects Data in Transit 
 
Point-to-point encryption (P2PE) protects card data presented to a business from the time it 
enters the environment until received by Fusebox. Encryption eliminates usable information 
before it travels through the Point of Sale (POS) system or network by applying advanced 
encryption that conceals the data. 
 
Tokenization Protects Data in Use and at Rest 
 
Tokenization replaces actual card data with a randomly generated unique ID ("token") that is 
sent in the response message. It eliminates the possibility of having real card data stolen 
because it no longer exists in your environment, while allowing you to use the token in place 
of the Primary Account Number (PAN) for necessary tasks. 
 
If you have subscribed to the SAFE-T Suite service, you will see minor differences within the 
Fusebox application, primarily in Online Case Management (OCM), Batch and Transaction 
Management, and Reporting. Within these Fusebox modules, you will no longer see card data, 
but tokens in the token fields and reports. 
 
Clear Card Guidelines 
 
The term clear card refers to the ability to view complete card numbers in clear text on the 
Fusebox portal screens and reports where card numbers are present.  Based on your 
entitlements, you will either see masked or unmasked account numbers in Fusebox search 
results and reports. If you are granted clear card access, you have the responsibility to secure 
and protect the information. 

 
System Timeout 
 
As an added security measure, the Fusebox application automatically logs you off after 15 
minutes of inactivity. Prior to the time out, you receive a warning message allowing you to 
select Continue Working. 
 
Notes: 

• System Timeout Message will pop up after 13 minutes of inactivity. 

• User has two minutes to either Continue Working or   Logout. 
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• If user does not make selection at 2-minute mark (15 minutes of inactivity in total), user 

will automatically be logged out. 
 

• When you have been logged off the system due to an automatic time-out, the following 
rules apply: 
 
• You must log on again to use the portal applications. 
• Any tasks or items you did not complete and submit prior to the time out are lost and 

you must re-enter them. 
 
Password Security 
 
Passwords provide the first line of defense against unauthorized access to Fusebox. User 
Setup manages passwords and reset actions in compliance with Elavon standards. 
 
For further information use the link below: 

Passwords and Access
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Chapter 3 - Accessing Fusebox 
 
Prior to using Fusebox, it is necessary to become familiar with the general requirements for your initial 
log on. You need to have the correct computer setup and your credentials for logging on to Fusebox. 
 
Topics in this section include: Before you Begin and Passwords and Access.  
 
 

Before you Begin 
 

• To be set up as a user based on your company's profiles and roles, a valid user ID and Password 
are required. 
 

• The preferred browser for Fusebox is Chrome.  
 

• Fusebox is also supported on Firefox and Edge Browsers. 
 

Notes: 
 

• While Fusebox may work while using Internet Explorer, it is highly recommended that users do 
not utilize Internet Explorer for the Fusebox application. Due to usage of Material Design for 
Fusebox development, while accessing Fusebox through Internet Explorer, users will 
experience slowness and delayed page response. 

 
• Please ensure you have the latest version of Adobe Reader to be able to view reports in PDF 

format. 
 

• A connection to the Internet is required. 
· 

Passwords and Access 
 
Obtain Password 

Your administrator sets up user accounts in order for you to perform specific functions or view 
certain information. However, to be able to assign you to the correct profiles and entitlements, the 
administrator must be assigned to the profiles and entitlements they are going to grant you. 

After the administrator creates you as a user, a welcome e-mail is generated that includes your 
username and a link to the user activation page where you can create a personal password. 

At the same time, you will also receive a second e-mail message, similar to the following, which 
includes your temporary password. 
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If You Do Not Have an Individual E-mail Address 
 
If you do not have an individual e-mail address or you share an e-mail with other employees, a 
designated administrator will verbally give you the Fusebox URL, your user name, and a temporary 
password for your initial log in to Fusebox. 
 
Password Requirements 

The first time you log on, the system prompts you to change your first-time password to a new, 
personal password. 

The Change Your Password screen indicates what the Password must Contain. 

 
 

Password Expiration 
 
The above screen also provides a Security Warning regarding password expiration, and includes the 
following information. 
 

• Passwords expire every 90 days, with warnings starting at 7 days prior to     expiration. 
 

• If your password is about to expire, the portal displays a message when you log on and indicates 
that your password will expire on a specific date. 

 
• If your password has expired, the Change Your Password page appears, forcing you to select a 

new password. 
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• If your password has not expired but you want to change it, this can be done using the Manage 
My Account link on the Welcome Menu Bar. 

 
Account Deactivation 
 
You are deactivated from using Fusebox after 90 days of inactivity. When you attempt to log on to the 
Fusebox application, you receive a generic message stating, You are not authorized to access Fusebox. 
 
Reset Password 
 
You can reset your password from the Login page by clicking Forgot your Password? And entering your 
username, and successfully answering three security questions. When you reset your password, you 
receive an e-mail notification that contains your temporary password. 
 
For security purposes, when you change your password, you receive an e-mail regarding your password 
reset. The E-mail reads: 
 

Dear Jane Smith: 
 

This notice is to confirm your recent password reset. If you did not request this change, please contact us 
immediately. If you did request this change, no further action is required. 

 
If you have any questions regarding this E-mail, please contact a gateway services representative at 866- 
265-6225. 

Sincerely, Elavon 

Gateway Registration Services 
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Chapter 4: Fusebox User Interface Overview 
 

Fusebox Portal 
 

The Fusebox portal provides authorized users the ability to access a single interface for delivering 
payments and other transactions from a merchant to any number of processors or acquirers. Fusebox 
is capable of supporting multiple Point of Sale (POS) systems downstream. For example, in a large 
lodging chain the gateway solution might consolidate transactions from the front desk, an on-premises 
sundries retailer, several restaurants, a health and fitness center, and pool or beach concessionaires, 
and deliver these payments to as many different acquirers upstream as appropriate. 
 
You access Fusebox on the Internet using your Chrome web browser by typing 
https://fusebox.elavon.net. This web-based interface provides a common user interface delivering 
various functions based on your user entitlements, which include: 
 
• A secure, hierarchical, rules-based access protocol based on an individual’s position or need to 

know. 
 

• The ability to manage transactions and access needed information including Online Case 
Management for better disposition of chargebacks and retrievals. 
 

• The ability to provide real-time comprehensive consolidated historical reporting for a variety of POS 
systems. 
 

• The ability to offer streamlined handling of administrative functions such as adding or subtracting 
users, changing passwords or entitlements, or providing access to value-added capabilities, such as 
Online Case Management. 
 

• The ability to enable authorized managers to add or remove necessary charges after authorization 
is complete. 

Gateway Solution 
 

Fusebox, as a hosted gateway solution, minimizes the data security and compliance liability for 
merchants, Independent Solutions Providers (ISPs), or Value Added Resellers (VARs). It effectively 
insulates critical security issues, disruptive updates, and costly and time-consuming certifications 
required in a rapidly changing payment environment. Elavon ensures the hosted gateway solution 
always incorporates the latest data security protections and meets the most stringent industry 
compliance standards. 
 

  

https://fusebox.elavon.net/
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Elavon’s hosted gateway solution can also deliver a broad range of added functionality, including: 
 
• Streamlined back-office settlement clearing 

• Consolidated reporting 

• Collecting information from all the different transaction end-points into aggregated reports 
 

The Fusebox portal incorporates standard Internet navigation features including tabs, menus, links, and 
buttons. With Batch Management entitlements, you can customize a dashboard of alerts, messages, 
and statuses on your Home screen for each of the several Batch Management features. 
 
Note: Based on your user privilege level and your user profile as established by the company, you may 
not see all available menu options or buttons. 
 
Topics in this section include: 
 
• Fusebox Navigation 

• How to Search 

• Viewing Records or Lists of Results 
 
Fusebox Navigation 

 
The Home tab for the Fusebox Navigation menu provides you with a quick snapshot of the features 
available to you. 
 
The left navigation menu allows you to go directly to the tab you want. Just hover over the icon to view 
tab options. 
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For easier and quicker access, expand the navigation menu by clicking the expand icon to view all tab 
names. 
 
 
All options display. 
 
Important: Do not use your browser’s back and forward arrow keys for navigation, or refresh your 
screen. Doing so may result in loss of data. 
 
Note: Always log out from the system to end your session. 
 
How to Search 
 
Fusebox portal applications offer search functionality through a search screen containing a list of 
search filter options. By specifying your criteria (search fields with a red asterisk are required) and 
clicking Search, you initiate a search based on the parameters you provide. 
 

 
 
When conducting a search, your list of results includes only items that fall within your selected 
hierarchy. You can narrow or widen your search by providing more or less specific search criteria. If no 
records match your search criteria, the system displays a message notifying you of this fact. 
 
Note: Depending on your search criteria, the retrieval process may take a long time to complete. If the 
system determines the query is taking a significant amount of time to complete, a confirmation 
message appears asking if you want to continue or refine the operation. 
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For more information on searching from the Home screen, refer to Change Hierarchy. 
 
Viewing Records or Lists of Results 
 
Many screens in the portal provide a list of rows, or records, allowing you to view information in the 
system in a particular timeframe or for a specified set of search criteria options. 
 
The default setting is to display 25 items to a page. Some page results will allow the user to change the 
amount of records per page from 25 to 50 or 100. 
 
If you are not seeing a record that you are expecting to see in the list, it may be because the item is 
further down on the list of records. You will need to sort the list or scroll through the pages of records. 
The total number of records found appears on the search result pages. 
 
Use the following options to organize your view of information in a list of records. 
 
• Sort Columns 

To sort by a list of records by information in a column, click the column heading. The list contents 
re-displays in ascending or descending order for the column heading selected. 
 

• Pagination Buttons 
To scroll through the pages of results using standard navigation arrow commands. 
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Chapter 5 - Welcome to Elavon Global Gateway 
 
The Fusebox portal provides specific menus to access the topics listed below. 
 
The links may appear differently on your screen depending on your user privileges and entitlements for 
each application to which you have access. 
 
Topics in this section include: 
 
• Change Hierarchy 

• Message Center 

• Account Menu 

• Change your Password 

• Update your Security Questions 

• Modify your Preferences 

• View your Account Settings 

• Log out 

• Help for Fusebox 

Change Hierarchy 
 
To view the data you need for your site or entity, it might be necessary to change your current 
hierarchy. 

1. You can search on various types of information to locate the hierarchy you want by clicking Change 
Hierarchy along the top right of the Fusebox screen. The change Hierarchy icon is a gold color. 

 
 
Note: If you do not see the Change Hierarchy link, you do not have the entitlement for hierarchy in 
your profile for that application. 
 

2. The user can change the hierarchy by using either the Hierarchy Search or Hierarchy Tree Search. 
 

3. From the top right corner of Fusebox, click Change Hierarchy or from the Hierarchy Search window you 
can either search by Hierarchy Search or from the Hierarchy Search Tree. 

The Hierarchy Search window appears. 
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4. From the Hierarchy Search window, select the hierarchy from the list or by typing the name into the 
box.  
 
Note: The Hierarchy Name is a required field. 

Search for a Hierarchy with Search View 
1. From the Hierarchy Search window, verify the Search tab is selected. 

 
2. Enter your hierarchy parameters. You can search using the following: 

Hierarchy Name (Required Field) 
 
• In the Hierarchy Name box, type or select the hierarchy. 

 
• For merchants configured to see different views of their property IDs, select the merchant-specific 

view option: System, Client or Alternate Client. 
 

• The default setting is System, which shows the Fusebox standard system assigned IDs. The Client 
and Alternate Client View, which shows the client-assigned IDs. 

 
Optional Fields 
 
You can filter the list of results contained within the selected hierarchy by entering information in the 
remaining fields. 

Select one of the following: 

1. Click Search. 

The Hierarchy Search window appears with search results. 
 

2. Select the desired Entity or Site of the hierarchy. When you select an Entity, the sites 
associated with that Entity are also selected. 
 

3. Use one of the following: 

• Select Use Selection and Go Back. 
 

• Select Change   Search. 
 

4. Click Search  And  Use Selection. 

• Search and Use Selection does not save your selection after you have logged out. Once you 
have logged out and then log back in, you will need to select your desired hierarchy once 
again. 

 
• Search and Use Selection bypasses the results screen driving the user back to the tab they 

were on before clicking change hierarchy. 
 
Note: You can set your favorite hierarchy within Account Menu | Settings | Preferences. Setting your 
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favorite hierarchy node will allow for your hierarchy selection to be defaulted to the favorite each time 
you log in to Fusebox. 
 

Search for a Hierarchy Using Tree View 
 

1. From the Hierarchy Search window, click the Tree View tab. 

The Tree Search window appears. 

2. In the Hierarchy Name box, type or select the Hierarchy        Name. 
 

3. Click Show in Tree. 
 

4. Select an Entity or Site from the   results. 
 

5. Use one of the following options: 

• Use Selection and Go Back 
This option makes the entity/site your current hierarchy and returns you to your home 
page. 

• Show Terminals 
This option takes you to the Search Hierarchy | Search View. 

• New Tree Search 
This option allows you to start a new search using the Tree View. 

 
View Your Current Hierarchy Selection 

 

1. To view your current hierarchy you can look on the Home Page to view the current hierarchy or 
use the Current Selection tab in the Hierarchy Search. 

Although the current hierarchy will show on the home page, if you have access to more than 
one hierarchy and do not have a favorite hierarchy set up through account menu | settings | 
preferences, then the system will display as "Current Hierarchy: Multiple Hierarchies." 

If you want a more detailed view of your current hierarchy, use the following steps: 

2. Select Change Hierarchy from the top right of the Fusebox window. 

The Hierarchy Search window appears. 

3. In the Hierarchy Search window, click the Current Selection tab. 

The Current Selection window appears which shows your current hierarchy selection. 

The current Hierarchy Search window will provide Name, ID, and Hierarchy Type 

4. To view additional details about a site or property, click on the hyperlink ID number in the ID 
column. The Site/Property Setup screen displays. 
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Message Center 
 
The Message Center allows you to view messages that are applicable to your access in Fusebox. 
Messages could be system wide advising users of upcoming maintenance windows or could be specific 
to your Hierarchy advising of a possible upcoming change. 
 
When you log into Fusebox, if you have a new message two things will occur. 
 
• A pop-up notification will appear alerting you of a new message in your inbox. 

• If you wish to disable this pop-up, check the Do Not Show Again checkbox. This change goes into 
effect the next time you log in. If you later decides to turn the notification back on, go to Account 
Menu | Settings | User Setup, and remove the checkmark on the Do NOT Display Pop-Up 
Notification Alerts field. 

• At the top right hand corner of Fusebox, there is an envelope. If there are new/unread messages 
available, a red circle with white numbering advises you how many new messages are available. 

 
To view your Messages. 
 

1. On the top right of the Fusebox screen, click on the envelope to view your messages. 

The Message Center Window displays. 

2. On the left side of the message center are the available messages. 
 

3. Click on any of the messages that you would like to read. 
 

4. After you have clicked on the desired message, the message will show on the right side of the 
message center. 
 

5. After you have read the message, the message can remain in your message center inbox until 
the message expiration date is met (default message center expiration date is 30 days), or to 
delete the message click the Delete button to the right of the message. 
 

6. Once you are finished in the message center, exit by clicking the Fusebox hyperlink in the 
breadcrumb trail, or select a new tab from the vertical menu bar on the left side of the screen. 

Note: Messages are incoming only and cannot be responded to. 
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Account Menu 
 

 
The Account Menu is located at the top right corner of Fusebox, as the blue bubble person icon. The 
account menu allows you to update your user settings, view the help menu, view the current Fusebox 
versions, and log out. 
 
Account Menu | Settings 
 
Security 
 
• Within the Security tab, you are able to change your password, edit your E-mail address, and 

update your security questions. 

• The Security tab only shows for External users. 
 

Change Password 
 
• Click edit and follow password guidelines. 

 
E-mail Address 
 
• Click edit and update your E-mail address. 

Note: to update your E-mail, you must enter your password before submitting. 

 
Security Questions 
 
• Click edit and you are directed to enter your password.  

• Once password has been successfully, submitted you will be directed to the security question 
update window. 
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Preferences   
 
Under preferences, you can update account settings for the following areas:  

• Hierarchy 
 

• Notifications 
 

• Cases 
 

• Batches 
 

• Reporting 
 

• User Setup 

 
Information  
 
Under the information tab, users are able to view their complete account settings. 
 
Change your Password 
 
You can change your password at any time. 

 
1. Click Account Menu found at top right corner of Fusebox   screen. 

 
2. From the drop-down, click Settings. 

New window displays with options for Security (external user), Preferences, and Information. 
Security is the default tab. 

3. On the Security tab, select Change Your Password (first option) | Edit. 

Change Password screen displays. 

4. On the Change Password screen, you will be directed to enter your current password, your 
new password, and confirm your new password (confirm by entering your new password a 
second time). 
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5. Follow the password guidelines to enter your new password. 
 

6. Once new password has been entered, click Submit. You will see a pop-up stating password has 
been changed. Additionally, you will receive an E-mail to the E-mail address associated with 
your Fusebox user account acknowledging the password change. 
 

7. Once new password has been submitted successfully, you will be directed back to the Fusebox 
Settings window. 

 
Update your Security Questions 
 
You can change your security questions at any time. 

 
1. Go to the Account Menu button on the right-hand corner of the screen. 

 
2. From the drop-down menu, click Settings. 

Settings window displays. 

3. Go to the Security Questions (third option). 
 

4. On the line for Security Questions, click   Edit. 
 

5. You are directed to enter your password. Enter your Fusebox password, and click Submit. 

Note: In order to update your security questions, you are required to enter your password 
before doing so. This is additional security through Fusebox to ensure your account is 
protected. 

6. Update your security questions, as needed. 
 

7. Click Continue. 
 

8. You will be instructed to enter your password one more time. Enter your password and click 
Continue. 
 

9. Your security questions are updated and saved. You are then directed back to the Settings page. 
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Modify your Preferences 
You can update your User Preferences at any time. 

1. Click Account Menu (right hand corner of Fusebox) | Settings. 

2. Click on Preferences, the second tab along the top. The Preferences window will appear. 

3. You can select a specific area to update your preferences by selecting an area of focus with the 
tabs on the left.  
 
Or you can scroll up and down through the preferences with the scroll bar on the right.  
 
Note: Based on your user profile, you may not have the entitlements to all portal applications. 

User Preference 
 

Favorite Hierarchy Node 
 
Options 
If previously selected, the user’s favorite hierarchy node displays 
 
Description 
You can either manually type in a node ID or search for the desired hierarchy node 
by clicking on the change hierarchy icon opening the Hierarchy Search screen.  Select 
your desired hierarchy and click Use Selection(s) and Go Back.  Once saved you will 
be directed back to the Preferences page.  
 
Note: 
The term node refers to a level in the merchant hierarchy.  The selection made here 
determines the default set of data that appears in the portal. 
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Notifications 
 
Alerts are only available if you have the Batch Management entitlements in your profile. These 
windows will appear on the Fusebox dashboard on the Home page. 
 
User Preference and associated Options and Description are listed below: 
 
User Preference 

Alerts 
Options 
Checkbox 
Description 
Check the box to enable Batch and Transaction Management alerts to display as a section on your 
Home tab. 
 
User Preference 
Batch Settlement Recap 
Options 
Checkbox 
Description 
Check the box to enable the snapshot of your Batch Management activity, including settlement status 
of batches in the system, to display as a section on your Home tab. 
 
User Preference 
24-Hour Batch Summary 
Option 
Checkbox 
Description 
Check the box to enable the number of received and confirmed batches over the last 24 hours to 
display as a section on your Home tab. 
 
User Preference 
24-Hour Transaction Summary   
Options   
Checkbox 
Description 
Check the box to enable the summary of your transaction Management activity, including authorization 
status of transactions in the system, to display as a section on your Home tab. 
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Cases 
For select fields user has the option to have notifications delivered to the Message Center with Fusebox 
or to the E-mail address saved to the Fusebox user account.  
 
User Preference 
Notifications - Case Aging   
Option       
Message Center or E- mail delivery method  
Description 
Check the box to enable the e-mail notification that lists all cases that are within the number of days 
remaining to respond, as specified in the Case Aging (# of days) preference. 
 
User Preference 
Case Aging (# of days) 
Option 
Use drop-down to select from 0 days to 10 days 
Description 
Indicates cases that fall within the specified number of days remaining to respond, as specified in the 
Case Aging (# of days) preference.  
 
User Preference 
Notifications - High Value Cases 
Option  
Message Center or E- mail delivery method 
Description 
Check the box to enable the e-mail notification that lists all cases that are greater than the High Value 
Amount specified in your user preferences. 
 
User Preference 
High Value Amount 
Option  
Type in amount (can include decimal value) ex. 1000.78 

Description 
Monetary amount which must be exceeded to appear in the High Value Cases notification. 

 
User Preference 
Notifications – Daily Summary  
Option  
Type in amount (can include decimal value) ex. 1000.78 

Description 
Monetary amount which must be exceeded to appear in the High Value Cases notification. 
 
User Preference 
Notifications – Daily Summary  
Option  
Type in amount (can include decimal value) ex. 1000.78 
Description 
Monetary amount which must be exceeded to appear in the High Value Cases notification. 
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User Preference 
Notifications – New Chargeback and Retrieval List  

Option  
Message Center or E- mail delivery method  
Description 
Checking the box enables the E-mail notification that provides a list of all new chargeback and retrieval 
cases. 
 
User Preference 
Notifications – Case Status Update  

Option  
Message Center or E- mail delivery method  
Description 
Checking the box enables the E-mail notification that provides a list of cases that have had a change in 
case status. 

Preferences 
Notifications 

- File Size Exceeded  

Option 
Message Center or E- mail delivery method  

Description 
Identifies cases that have not yet been submitted because they exceed the size limit for a case. 

Preference  

Notifications 
- Case Status Returned to New 

Option  
Message Center or E- mail delivery  

Description 

Identifies cases that have returned with time left to provide a new response.  
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Batches (applies to user with batch management entitlements) 
 

User Preference  

Transaction List sort by  
Options 

Select Option from drop-down 
Site ID - Card Type 

Site ID - Date/Time 

Description  
This section specifies how the list of records in the Transaction List page is sorted. 

 
User Preference 

Transaction 

/ Batch List 
- Rows per page  

Options 
Select option from drop down, 25, 50, 100 

Description 

This value specifies the number of records (rows) that appear on each page in the Batch List or 
Transaction List of results. 

The system default setting is 25 rows to a page. 
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User Preference 
Save My Previous Transaction Search Data Range 

Options  
Check Box 

Description  

Check the box to enable the date range to be kept for future searches. 
 

Reporting 
User Setup 
 
User Preference  

Preferred Landing Tab  

Options 
Drop-down list 

Description  
Select which portal application appears by default when you log on to the portal. 

Note: You may not be set up for access to all the listed applications. 
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User Preference  
Preferred Language  
Options 

Drop-down list 

English 

Spanish 
Description  

The initial implementation of the system shall be available to merchants in North America. In future 
phases, multi- language support will be available. 
Currently, Spanish is not available. 

This selection determines the language of e-mail and postal letter communications and the language in 
which the contact will see in the portal. 
 
User Preference  

Preferred Language 

Options 
Drop-down list 

English 
Spanish 

Description  

The initial implementation of the system shall be available to merchants in North America. In future 
phases, multi- language support will be available. 

Currently, Spanish is not available. 

This selection determines the language of e-mail and postal letter communications and the language in 
which the contact will see in the portal. 

 

User Preference  
Locale  

Options 

 
Drop-down list 

English (United States) 
Spanish (Canada) 

 

Description  

Dictates the display format of number, currency, date, and time. 
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User Preference  
Time Zone  

Options 
Drop-down list 

English (United States) 
Spanish (Canada) 

Description  

Times displayed in the system will be in the time zone specified by this field. 

 
User Preference  
Hierarchy Node Label  

Options 
Hierarchy Type Node Name 
Hierarchy Type and System ID 
Hierarchy Type and System ID and Node Name 
 

Description  

Affects User Setup only. 

The selection established how hierarchy nodes appear within the user interface. 
User Preference  

Notifications Alert  

Options 
Checkbox 
Description  
Keep the Do NOT Display Case Response Fee Alerts unchecked to receive cases that have fees attached to them that you are 
assigned to.  

 

User Preference  
Hierarchy Node Label  

Options 
Drop-down list 

English (United States) 
Spanish (Canada) 

 

Description 

Do NOT 

Display Pop-Up 
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View – Merchant Hierarchy 

Drop-down list contains custom hierarchy views, based on merchant configurations. This conditional 
field only appears for merchants who are set up to have multiple hierarchy view options. For merchants 
configured to accommodate other views of their Property IDs, this additional field appears with the 
merchant’s hierarchy name as the label. 
The default view for Fusebox users is System, which shows the standard system assigned IDs. 

3. When you are finished making changes, click   Save. 

The Preferences confirmation screen appears. The preference settings will take effect the next time 
you log on. 

4. Click Close. 

 
View your Account Settings 
 

 
1. You can view your Account Settings at any time by using the Account Menu button on the 

right-hand corner of Fusebox, then by clicking Settings. 
 

Note: E-mail addressed associated with user account will show in E-mail field. 

2. The third tab along the top is Information.  Click on Information. 

The Information window displays. 

Logout 
 

1. You can log out at any time by clicking on the Account Menu button on the right hand corner of 
Fusebox. 
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2. Select the last option, Log Out. 

 

 

3. After you click log out, a confirmation window displays. Click Yes to complete log out. 

 
Help for Fusebox 
 
Fusebox has a built-in help system to assist you in acquiring detailed information and instructions about 
any of the available portal applications you are entitled to use. A separate online help system is 
available for each application in the portal. 

1. You can view the Help Menu at any time by clicking the Account Menu button on the right 
hand corner of Fusebox. 
 

2. Select the option for Help. 

 
The Help Menu/System will open in a separate browser window. 
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Chapter 6 - Available Applications 
 
Fusebox application tabs are available on the left hand column of the screen.  Each 
application has its own icon.  To see the application name along with the icon, click 
on the menu above the icon list.    
 
You can close the application names so that only the icon shows by clicking on the 
menu once again.  
 

 
 
Note: Based on your profile/entitlement level as established by the company, available applications will 
vary.  
 
Topics in this section include: Fusebox Applications List and Home Tab.  
 

 
Fusebox Applications List 

 
The Fusebox portal includes access to the following tabs (applications). 
 
 Home 
 
Home provides a snapshot of your Fusebox activity, including statuses of items in the system, the 
number of items relating to the statuses, and alerts and system messages. You must be assigned the 
Batch Management entitlement to see the alerts on the home page. All count values and alerts contain 
links to list and detail information. Contents vary based on your user profile and are set by each user as 
part of their preferences. 
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Boarding (Internal Users Only) 
 
Boarding involves the boarding of new accounts and servicing systems for Fusebox customers and 
customers of the Online Case Management application who use Elavon as their acquirer. Boarding 
provides tools for merchant setup, terminal setup, and processor configuration. All needed 
configurations for a merchant to use any feature of the portal are set up and modified using this tool. 
 
Case Management 
 
Case Management provides the ability for merchants to manage chargeback and retrievals. Merchants 
can view and respond to cases and track all requests to ensure they are being responded to within the 
time allotted. Based on user entitlements, additional functionality is available to manage cases. The 
system utilizes a workflow managed process, with capability to define custom queues, assign users to 
cases, and update statuses based on date received or actions performed. Users can create and edit 
standard response letters to be used as templates for auto-assisted response, as well as for manual 
responses. Images can be associated to cases using the assisted response rules, or manually added by a 
user. 
 
Batch Management 
 
Hosted gateway real-time authorization and settlement system. It provides tools for reviewing and 
managing batches, allowing users to view transaction and batch level data, settle batches, search on a 
variety of criteria, and research and resolve batch and/or transaction issues. Users can view, and if 
necessary alter, batches and transactions at various points during the life cycle. Typically, users with 
access to the Batch Management application also are granted access to the Transaction Management 
application. 
 
Transaction Management 
 
Provides access to information relating to hosted gateway transactions in the system. From this tab, 
you can view counts and amounts of transactions in the system and their status. Using the menu bar 
you can search for transactions and create batches, view and manage all transactions within a batch, 
create a new transaction, and add an authorization file to a batch. 
 
Token Conversion Browser 
 
The Token Conversion Browser is used to generate a token for credit card numbers to prevent 
unauthorized use.  It is also used to convert token numbers back into the actual credit card number. 
These functions are called Protect and Unprotect respectively. 
  
 Settlement Control (Internal Users Only) 
 
Similar to the Batch Management and Transaction Management applications but provides additional 
functions and internal statuses which are used by Elavon employees to manage settlement of incoming 
batches with third party processors (TPPs). An automated back office process creates one or many third 
party processor batches from a merchant batch, depending on the number of end-points involved. The 
batches are then sent to processors for deposit. If errors or issues arise, settlement control users use 
this application to research and resolve the problem. 
 



Chapter 6 – Available Applications   FSB-0047-A 
   

 
© Elavon, Incorporated, 2021  P a g e  | 40  

File-based Activities 
 
Supports all file-based processing, generally used by cruise line merchants with on-board authorization 
and settlement of credit cards.  File based activities includes a variety of functionality such as (but not 
limited to) creating/editing voyages, uploading batch files, viewing file details, and monitoring file 
processing status and activity. 
 
Oracle Payment Interface (OPI) Configuration 

 
OPI Configuration is a middleware product that translates messages received from Oracle POS/PMS 
systems into the Elavon Gateway API message format and routes the traffic to the Simplify terminal 
connected to a particular Oracle workstation for card present traffic or directly to Fusebox for card not 
present traffic. For the Elavon Bridge to work with Oracle’s OPI it must be pre-configured with 
information that will allow mapping of Oracle workstation number to the Fusebox locator values. These 
locator values are setup for the customer terminal when the site is boarded on to Fusebox which allows 
the Bridge to communicate between terminal, PIN pad, and Fusebox. 
 
Reporting 
 
The reporting applications helps provide and in depth view of your business’ activity within 
Fusebox.  Users with proper entitlements are able to view a variety of reports ranging from 
batch/transaction management, audit reports, and fraud management to name a few.  Reporting 
enables you to customize your report results through search parameters, print/save reports, and 
export reports to a variation of outputs such as HTML, PDF, and CSV.  
 
User Setup  
 
User Setup is an application within Fusebox typically used by Administrators.  Admins are able to 
add/modify/deactivate user accounts as needed.  This includes selecting specific profiles and 
entitlements for users and specifying the level of the merchant hierarchy to which users shall have 
access to.  
 
Support (Internal Users Only) is the application for internal Tier II/III support users that provides:  
 
• A Log Viewer to query log messages in the database. 
• The ability to drill down to see individual events and their associated detail data for each record. 
• A Bulk Loader tool for new user setup of large merchant conversions. 
• A Log Viewer to query log messages in the database. (For Internal Users Only) 

 
S3 Admin   
 
The S3Admin tab is an internal user only tab for Registration IDs and Token Types that are utilized by 
Token Vault Merchants.  
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Fusebox Home Tab 
 
Users with the proper profile/entitlements will have a home page view via the Home tab. By default, 
the Home tab is the landing page once you have logged into Fusebox. 
 
Please note the landing page can be updated to a different Fusebox tab by going to 
Account Menu | Settings | User Setup. 

 
The Home page can be updated through Account Menu | Settings | to customize your alerts, 
messages, and statuses. 
 
Notes: 
 
• Dashboard Alerts will only be available on the Home tab for those users with access to Batch 

Management applications. 
 
• Upon logging in for the first time, please know that dashboard alerts will not be shown. You must 

set your preferences to view the available alerts through Account Menu | Settings | Preferences. 
 

Alerts 
 
This window shows notices that require immediate attention. Click the blue text of Batch Management 
Alerts or Transaction Alerts message to view more details. 
 
24 Hour Batch Summary 
 
Provides count of batches received and batches confirmed. Value is a hyperlink that will direct you to 
details of the batches 
 
Batch Management 24 Hour Snapshot 
 
This window shows batches that have been received and confirmed in the past 24-hour period. Click on 
the number hyperlink to view details of the batches. 
 
Batch Settlement Recap 
 
This window shows status of batch settlements. 
 
Note: Based on your profile/entitlement level as established by the company, available applications will 
vary. To obtain details about the Fusebox applications, see Fusebox Applications List. 
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Chapter 7 - Common Tasks 
 

This section lists known environmental settings that can affect Fusebox users when 
performing operations in the portal.  Each topic lists a known configuration item, 
followed by an explanation of how to best resolve it. 

 
Topics in this section include: 
 
• Refreshing Content 

 
• How to Print from Fusebox 

 
Refreshing Content 
 

Information passes through the system in near real-time.  The contents on the Home 
tab initially loads information at the time you log in to the system. The information 
on the Home page does not automatically update on its own. 
 
• To view the most recent information in the system, click Refresh on the Home tab. 
• The date and time of the last refresh is displayed to the left of the refresh button. 

 
Note: Do not use your web browser’s refresh to access previously viewed pages. This 
may result in loss of data. 
 

How to Print from Fusebox 
  
To print from the Fusebox portal, use one of the following methods: 
 
• Many Fusebox portal application pages display a list of results or records where you can click the 

print button or hyperlink to print the contents of the screen to a printer-ready format. 
 

• Many pages that display a list of results provide an option to export the results to another file 
format to allow you to download the information and print it from that application (for example 
Microsoft Excel). 
 

• Use your Web browser’s print features to print content that appears in the display area of your 
browser window.  However, as with any browser Web page display, if what you want to print is 
wider than the paper size set in your printer, you run the risk of cutting off data and not getting the 
entire information that you want. 
 

• Create a screen capture by pressing Print Screen (PrtScn on some keyboards), and paste the screen 
capture into a document or other file.  You may have better printer output results if you change the 
page orientation from Portrait to Landscape before printing. This can be done in your print options 
screen.   
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• If you have been granted access to view full, unmasked account numbers, it is important to 
remember that you are responsible for protecting any information you print. 
 

• Create a screen capture by pressing Print Screen (PrtScn on some keyboards), and paste the screen 
capture into a document or other file.   

You may have better printer output results if you change the page orientation from Portrait to 
Landscape before printing using your print options screen.   
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